KDE User's Guide
by Papawoob

Creating a Favorite Applications Menu
by Pam Dougan

Free as in Free Beer
by Merlin Whitewolf

Bringing Linux to the Kids
by Neptune

Vista Sucks Big Time
by R. Adkins

What's in a Password?
by Trolum

A Letter to My Windows Friends
by Neptune

What is "ROOT"?
from the PCLinuxOS Forum

Simple Ways to Do Things
by ClareOldie
From the Chief Editor's Desk

Welcome to our April, 2007 issue of PCLinuxOS Magazine. Our staff has been very busy this past month, finding material and preparing it for your enjoyment. There is a good explanation of the many meanings of the word "root"; a piece on the phrase "free as in free beer"; and a 'how to' on creating a favorite applications menu. Also this month we have the first installment of a multi-part KDE User Guide, complete with screenshots direct from the latest version of PCLinuxOS — 2007 TR3. Each month until we finish, look for another installment. Neptune, one of our favorite posters on the main forum has kindly provided several interesting pieces, both serious and humorous.

It's been an interesting month. Texstar took a well earned vacation (you may have seen the post about it with a link to an article on Tuxmachines.org by SRLinux - http://tuxmachines.org/node/14215). There are some interesting pictures in that article. We all hope Texstar enjoyed himself and comes back refreshed and ready to pump out PCLinuxOS 2007 final version.

As you all know, development of PCLinuxOS is ongoing, and there are great things planned down the road. Here's one we'd like to see:

**Newsflash just in:** Dateline April 1, 2007 — Our ace reporter Danny Crane tells us Sir William Gates, long known for his altruism and charity, but also known for recognizing ways to make money when he sees them, has decided that he is going to relieve himself of the dinosaur that is Windows and invest in a rising up-and-coming Linux distro called PCLinuxOS. The brainchild of a genius who goes simply by the name of Texstar, PCLinuxOS has come into its own with the release of PCLinuxOS 2007. Having been in development for about four years PCLinuxOS has far surpassed the best efforts of Windows in its many-year history. It is rumored that Sir William is also engaged in talks with Warren Buffet to see if he wants in on the ground floor of what is almost certain to be the most successful computer operating system yet. We will have more for you as the story develops.

See you next month.

Tim Robinson

---

**PCLinuxOS Magazine** is a community project of MyPCLinuxOS.com to provide an additional means of communication to the PCLinuxOS community.

**Project Coordinator:** Derrick Devine
**Publisher:** MyPCLinuxOS.com
**Contact:** mag@mypclinuxos.com

**Proofreaders:** Doug Wilson, Seán Leamy, Jan Allen, Danny Crane, Guy Taylor, James La Rue, Duane Trudeau, Dave Doak, Pam Dougan, Jared Bernard

**Contributors:** Clare Oldie, Merlin Whitewolf, Pam Dougan, Neptune, Tsolum and R. Adkins

**HTML Codes:** Galen

**Page Layout:** Archie Arevalo

**Additional Graphics:** tame and gryphen
PC LinuxOS 2007 Test Release 3

Text and the Ripper gang are proud to announce that PC LinuxOS 2007 Test Release 3 (Almost There) is now available for download and testing. The kernel has been finalized, applications updated and various issues cleared. Some additional cosmetic changes applied based on user feedback from our Test 2 release. Progress but not perfection ... yet.

Disclaimer - This is experimental software. Use at your own risk. PC LinuxOS cannot be held liable under any circumstances for damage to hardware or software, lost data, or other direct or indirect damage resulting from the use of this software. If you do not agree to these terms and conditions, you are not permitted to use or further distribute this software.

Livecd boot options:

* Livecd - Default boot options
* Safevideomode - Boot using generic video drivers (Proprietary drivers available after install)
* Safe - Turns off most hardware probing
* Mediacheck - Test the media to determine a good burn to cdr
* Memtest - Test your computer memory

Additional Cheat Codes: (can be typed on the command line)

* nousb - skip usb probing
* noscsi - skip scsi detection
* nosound - skip sound detection
* nocpufreq - skip cpufreq module detection
* nopcmcia - skip pcmcia detection

What's New:

The kernel has been finalized and updated on the livecd. This kernel (2.6.18.6) supports up to 4 gigs of memory and is smp aware. It replaces the i586 legacy kernel which only had support for up to 1 gig of memory. We hope this change will provide a better experience for those with modern computers. We will consider providing a legacy iso for those with very old computers if needed at a later date.

Many applications were updated on the livecd including Firefox 2.0.0.2, Scribus and a new build of Open Office with more international support. The KDM login manager
was updated and now supports user selection from menu instead of having to type your name and password. The boot splash was updated with better colors in verbose mode based on user feedback.

We cleared as many issues as possible from Test 2. There are still a few things to clear. As you know with so many different hardware setups it is almost impossible for any distribution to cover every combination of wireless, sound and video setup.

**Known Issues:**

* Various hardware configuration and support for (wireless, sound, video etc...)
* Misc software issues (vnc, menu editing, suspend not 100% etc...)

Requirements: 256 mb of memory, 5 gig of free hard drive space, modern cdrom drive, Pentium 3 700 mhz cpu or better.

The iso you want to get is called livecd-TR3.iso Size: (723,943,424 - or approx. 690 Mb)

**Current Download Mirrors** (as of March 5rd 12:45 pm CST):

Atlanta, USA
The Netherlands (NLUUG/SURFnet)
Dublin, Ireland
Belgium
Czech Republic
Poland
Indiana, USA
Switzerland
Romania
Oregon, USA
Roma, Italy

Preface

This user guide is meant as an introductory guide for a user to use a modern personal computer (PC) running a Linux operating system. The main aim is to provide a self-learning guide on how to use a modern Linux desktop system. It assumes that the user has no prior knowledge of Linux or PC usage.

After going through the guide the reader should be in a position to start using a Linux desktop for both personal and office use. In particular the user should be able to:

- access the Internet and use the WWW and Internet email
• manage files and folders, and manipulate the file system
• produce and print simple documents and presentation materials
• advance to become a power user by further self-learning and exploring

Chapter 1 — Getting Started

I've updated this guide to reflect the desktop environment called KDE. It is "Windows" like with a few more bells and whistles. I've taken the screenshots from my computer, which won't be set up exactly the same as yours, but will be pretty close.

In order to start using your system you will usually have to perform what is known as a user login. This procedure is necessary to identify yourself to the system. The system allows multiple users to use it concurrently so, it has to be able to identify a user in order to grant them the necessary privileges and rights to use the system and applications. Each user, upon successful login, will be assigned to his home directory (folder).

Some systems may have been set up so that upon power-on, a default user is logged in automatically. If this is so, then you will not be presented with a login screen or prompt as described in the section below. You may skip on to the section entitled "Basic Navigation using the Mouse on the Desktop."

Note:
There is a special user called root, or superuser (this user is usually created during the system installation) which has unlimited access and rights to all the system files and resources. You only need to login as root if certain system level administrative tasks are to be carried out. Otherwise, there is usually no need for a normal user to login as root. This is to prevent accidentally damaging the system by deleting or modifying important system files.
Text Based Login Prompt

To login, enter the username followed by the ENTER key and when the password prompt appears, enter the password followed by the ENTER key. You are now logged onto the system and may issue commands if you wish. For this exercise the only command you need here is startx, which starts the Graphical Interface.

Graphical Login Screen

When you reach the login screen, type in your username and then type in your password and hit enter. This will bring up a splash screen showing your desktop being loaded as seen on the middle screenshot on the left:

When the blue lights on the bottom finish lighting up the next thing you will see is your KDE desktop as seen in bottom screenshot:

Starting The Graphical Desktop

If you have used the text-based screen login, you will have to start the graphical desktop manually by entering the command startx, followed by the ENTER key.

If you have logged in from the graphical login screen, the graphical desktop will be started automatically for you. The graphical desktop presents a Graphical User Interface (GUI) for the user to interact with the
system and run applications.

**Note:**
The graphical desktop that we will be using throughout most of this guide is called the KDE Desktop. There is another desktop environment in popular use on Linux systems — the GNOME Desktop. There is some coverage of GNOME later, comparing the similarities and differences between GNOME and KDE although we will not be covering the GNOME desktop in detail.

For the rest of this user guide, when we refer to the graphical desktop or Desktop we will be talking about the KDE Desktop unless stated otherwise.

**Using The Mouse On The Graphical Desktop**

Proper usage of the mouse is essential in order to have a rewarding and productive experience on the graphical desktop. Most Linux graphical desktops are designed for use with a 3-button mouse. If you are using a 2-button mouse, during installation, it should have been configured to emulate the middle-button of a 3-button mouse by pressing both buttons simultaneously.

To click on a mouse, the left button is depressed. (A mouse configured for a left-handed user will need to have its right button depressed.) The right (or left button for a left-handed mouse) and middle buttons are usually used to invoke special or specific features of the GUI and instructions to do so will be explicitly given.

The term "clicking on the mouse" means that you click on the mouse once.

The term "double clicking" means that you click twice in succession on the mouse.

To "select" an item means clicking it once with the mouse.

The term "drag and drop" means that you will have to
click on an item and while continuing to hold the mouse button down, drag the item to another place and on reaching its destination, drop it by releasing the mouse button.

**Exercises**

1. Open the home folder from the Desktop.
2. Close the home folder window by clicking on the close window button at the top right-hand corner.
3. Right-click on the trash icon, view its properties and then close it.
4. Move the trash icon to another location on the desktop by using the mouse to drag it to the new location and then releasing the mouse.

**Main Components Of The Desktop**

There are 3 main components to a KDE desktop. They are:

1) The Menu System
2) The Panel
3) The Desktop Itself

**The Menu System**

The main menu can be accessed by clicking on the Main Menu button located at the extreme lower left hand corner of the desktop. It looks like the following:

Clicking on this will bring up the Menu System as shown in the figure on the left.

From the Menu System you can start many of the applications installed on your Linux system. Note that the Menu System consists of a Main Menu panel and sub-menu panels. Each entry in the Menu System which has an arrow on its right means that it is an entry point
to a sub-menu, and there can be sub-menus within each sub-menu. In this way, applications in the Menu System can be organized and categorized for easy reference and access.

To access the sub-menu associated with a menu entry, move the mouse and rest it on the menu entry in question and a sub-menu panel will appear as seen on the left:

Clicking once on a menu entry will cause an application associated with it to be launched, i.e., executed.

**The Panel**

The long bar across the bottom of the desktop screen is called the Panel. The Panel contains the Main Menu icon, the application launcher icons, a notification area and applets.

**The Panel**

Installed by default are several application launcher icons on the Panel. These are: Show Desktop, Home Folder (My Documents), PC LinuxOS Control Center (Control Panel), Synaptic Package Manager, and Mozilla Firefox (Web Browser). Clicking on one of these will run the application. Commonly accessed applications can be added to the Panel and those that are less frequently used can be removed.

The notification area holds alert icons so that the user can be alerted to critical messages.

Applets are small applications that run on the Panel. These usually perform useful and informative tasks like setting the sound level of the sound card, monitoring whether the system software needs an update, weather, etc.
**The Workspace Switcher**

The graphical desktop can be regarded as a workspace drawing an analogy with the working area on a real physical tabletop. Programs are run, documents displayed and files opened on the workspace. To cut down on workspace clutter and to enable the user to organize his workspace more efficiently, the graphical desktop environment allows the usage of multiple workspaces. Each workspace can be considered as a virtual desktop.

By default the user has 4 desktop workspace areas to work on. The workspace switcher represents each workspace as a small square and shows the applications running in each of them. To access a workspace, click on the square with the mouse.

**The Taskbar**

The Taskbar applet is located next to the workspace switcher and shows the titles of all the running applications in a virtual desktop (a workspace).

**The Desktop Space**

The Desktop space refers to the rest of the screen. It contains icons which are graphical representations of short-cuts to application launchers, file folders, files, and peripheral devices like floppy disks, CD-ROM drives, and printers. Double-clicking on an icon representing an application will launch or execute the application. Commonly used applications and/or files/folders are usually placed on the desktop space.

**Using The Window Manager**

An interactive application that is run on the graphical desktop is usually displayed inside a window. This
window can be accessed and manipulated using the window manager.

**The Titlebar**

When an application is started, an application window opens and a frame (see figure on the left) is placed around the window of the application. The top edge of the frame has a title bar that contains the title of the application. See the screenshot below:

At the left hand corner of the title bar is the Window Menu button. Clicking on this button will open up the Window Menu.

You can perform operations such as minimize, maximize, move, resize and close the window from this menu. At the right edge of the title bar there are three buttons which allow you to minimize, maximize, and close the window.

To perform an operation in the Window Menu, open the menu by clicking on the Window Menu button and then select the desired operation.

**Manipulating The Window**

Some basic instructions to manipulate the windowing system are given here. More details can be obtained by clicking on the Main Menu and then on More Applications, Documentation and then KDE Help Center. After the KDE Help Center opens choose KDE User Manual and scroll down to "Windows, How To Work Them."

**Focus** — In order for a window to receive input from the mouse and the keyboard it has to be the window "in
focus." Only one window can have focus at a time. Windows that are not in focus have their titlebars grayed-out. To focus on a window place the mouse on the titlebar and click on it. (You can actually click anywhere within the window, but it is safer to click on the titlebar since there is no possibility of accidentally clicking on some item selection or functionality of the application running within the window.) If the window is not visible, you can click on the taskbar on the Panel at the bottom of the Desktop to bring into focus the window you want.

Maximize and Minimize — Maximizing a window means that the window is expanded to cover the whole desktop, while minimizing it means that the window is taken off the desktop and it appears as an icon in the taskbar on the Panel.

You can maximize a window which has focus either from the Window Menu or by clicking on the maximize button on the titlebar. You can similarly minimize the window. If the window does not have focus, bring it into focus by clicking on the taskbar on the Panel.

Resize — You can resize a window, i.e., change its size, by placing the mouse at an edge of the window and then drag the window to the desired size.

Move — To move a window to another place on the desktop, place the mouse on the titlebar and drag the window to the desired location.

Close — You can close a window which has the focus either from the Window Menu or by clicking on the close window button on the titlebar. If the window does not have focus bring it into focus first by clicking on the taskbar on the Panel.

Note: Closing the window may terminate your application.

'Blind' — You can reduce the window size to just the title bar (like a window-blind) by double clicking on the title
bar.

**Move to Workspaces** — The Window Menu can be used to move the application currently opened to another workspace or to all the workspaces.

**Exercises**

Open your home folder from the Desktop. Perform the following operations on the opened window:
- maximize it
- minimize it
- resize it
- move it to another area of the desktop
- place it on workspace 3
- reduce it to just the title bar
- close it

**Ending The Session**

To end this chapter, you can exit your session on the desktop by performing what is known as a logout.

If you do not want to use the system any more, you can turn it off by performing a system shutdown.

**Logout**

When you have finished working on the system, you will need to logout. Logging out will inform the system that you are no longer using the system’s resources. All the files opened and programs run by you will be closed and/or stopped unless you have specifically informed the system to keep them open or running for you.

To logout, at the Main Menu select: **Main Menu --> Log Out** and at the dialog window select **End Current Session** and click **OK**.
Shutting Down The System

When you have finished using the computer and want to power it off, you will need to perform a system shutdown. To shutdown, at the Main Menu, select logout. Then, at the graphical logout screen select the "Turn Off Computer" option. You will also have the option to "Restart Computer."

Note:
It is very important that a proper system shutdown is performed. You should not just turn off the power switch of the computer to shut it down. Failure to observe this may lead to system software and data corruption and failure.

This ends the first chapter in an ongoing series of articles. By the time we are finished anyone that reads will feel very confident while moving around in the PC LinuxOS 2007 KDE desktop environment. See you next issue!
A Letter to My Windows Friends

Dear Windows Friend,

What's wrong with this article?


What's wrong isn't what's in the article - it's what isn't in the article. Here's what's wrong - nowhere is Microsoft, and their products, such as Internet Explorer, Outlook, Outlook Express and Windows mentioned. And that's not just wrong. It borders on negligent reporting. Because Microsoft is largely culpable for the plague of spam infesting your email. And your Windows PC may be helping.

Computer columnist Robert Cringely wrote, back in 2001:

"The wonder of all these Internet security problems is that they are continually labeled as 'e-mail viruses' or 'Internet worms,' rather than the more correct designation of 'Windows viruses' or 'Microsoft Outlook viruses.' It is to the credit of the Microsoft public relations team that Redmond has somehow escaped blame, because nearly all the data security problems of recent years have been Windows-specific, taking advantage of the glaring security loopholes that exist in these Microsoft products."

In November of 2003, John Dvorak wrote:

"The [Outlook Express] product has been under fire since its release, and almost every major virus uses Outlook's open-door security policy to turn individual
mailboxes into spam-o-matic emailing machines."

Several years have passed and those words still ring as true today as they did in 2003 - or 2001. Microsoft appears clearly unable or unwilling to clean up their software to the degree that it requires. Their frequent "critical updates" seem to be little more than sticking band-aids on a highway trauma victim. Even the much-vaunted “Patch Tuesdays” have been described as an invitation for the exploit writers to test and send out their next round of viruses and trojans.

The mainstream media virtually never makes the distinction between "computer" trojans/viruses and "Microsoft" trojans/viruses. Maybe the mainstream media doesn't know any better. Or maybe the mainstream media gets a heck of a lot of advertising revenue from Bill Gates.

In my view, it's this simple. Windows desktop and server PCs are a train wreck on the Internet that have caused literally billions of dollars of damage to computer users and businesses. That is not the cost of doing computer business. That is the cost of doing bad computer business.

Maybe you didn't know this - and that's not your fault. But the fact is, you were sold a PC that had severe security problems in the fundamental design of its software, and even worse problems in its default setup. If it weren't for the agreement you made in the form of the MS EULA (yes, you agreed to it) you might even have grounds for a class action lawsuit.

But it's time to wake up. Now you know better. And my message is simple - run something besides Windows, at least when you're connected to the Internet. Chances are, your machine can run both Windows and Linux. I'll even help you set it up. Use Linux to surf and do email. Run Windows for what it's safe for - playing games. With your network cable unplugged, please.

Or buy a Macintosh. But please, don't sit there and
wonder why your inbox is flooded with spam while running five hidden tasks on your zombied Windows PC that is spreading viruses and flooding the Internet with even more spam without your permission or knowledge.

Ahh, but you have an antivirus program installed. Great. There's just one problem. The new hackers aren't bored kids sitting in their parent's basements playing at hacking your PC. The new hackers are highly trained, well-financed, professional criminals. Do you seriously think that they can't afford to buy a current copy of Norton/Symantec or McAfee and thoroughly test their trojans and viruses against the same antivirus you have? The easy accessibility of VM (virtual machine) software even leads to the possibility that some of the new trojans may have their own virtual machine, or exploit existing VM software and literally run Windows as a guest operating system - from which vantage point they would be impossible to detect from Windows, regardless of what kind of antivirus you're running.

http://it.slashdot.org/article.pl?sid=06/03/11/0130221

And even at their best - at their absolute best, antivirus programs will always be a jump behind the bad guys. When a new virus is created it takes time to notice the virus; to report it to the antivirus companies, for the companies to dissect the virus and figure out how to identify it; then more time to figure out how to clean or disable it; then more time to add that to an update file and get that file distributed. We're talking quite a few days. How long does it take a virus to spread globally? Hours.

Are you afraid to learn how to use Linux or a MacIntosh? Don't be. Remember, you weren't born knowing Windows, and the transition is easier than you think. Personally, I'd be a LOT more afraid of passing out my credit card numbers, my social security number and my address. I'd be a LOT more afraid about giving out all my bank account information and passwords. I'd be a LOT more afraid of the FBI knocking at my door wanting to know about the illegal porn I've been emailing out.
Awwww, it couldn't be that bad, could it? Consider, in 2004, the Norwegian telco provider, Telenor shut down a server controlling a "bot-net" of 10,000 "zombie" PCs.

http://www.theregister.co.uk/2004/09/09/telenor_botnet_dismantled/

But 10,000 PCs - that's nothing, right? OK, how about this: In September of 2005, Dutch police arrested a trio controlling a zombied network of 1.5 million (yes, million) PCs - all Windows machines, every last one of them. And the zombie software is getting smarter — new zombies are using peer-to-peer technology and coordinating with multiple master servers. You can't just cut one head of the hydra and think you've killed it anymore.

It's 2007 now and the current levels of spam, viruses and trojans points to even bigger networks. Much bigger. And none of the people using these millions of PCs even suspect anything is wrong with their computer. None of them have any reason to doubt that their antivirus protected them. None of them think for an instant that their machine is part of the problem. And neither do you.

Look at it this way. You worked hard. You saved. You bought your PC. You thought you owned it. But Bill Gates gave it away to some Ukrainian criminal organization. They're the ones running your PC, and the only reason you can use it at all is because you have their permission. And you still want to surf the web with Windows?

Be my guest. But when you get tired of wondering why your browser doesn't go where you want it to, when you get your fill of the slow machine that used to be fast, when you start wondering if your entire identity isn't for sale on a foreign website... give me a call.

Your Linux friend,
Neptune
Creating a Favorite Applications Menu

I spend time in the Forums, just like everyone else, and while I was there I saw a post asking about a Favorite Applications shortcut menu. We all have a few applications we use almost all the time, but don't want to clutter up our panels or desktop with all those icons. I read the reply from Pastor Ed and wanted to share it with you. His method places a sub-menu in the KDE menu.

Right click on the existing KMenu entry, and select Menu Editor.

Next, create a new submenu -- File > New Submenu and name it whatever you want -- MyFaves.

(To keep it out of sight of your main menu entries, place this new MyFaves menu in a subdirectory, like the More Applications submenu.)

Once it's created, start adding your favorite applications to it. You can either use the File > New Item to create them from scratch, OR select existing menu entries wherever they are. Use Edit > Copy, then navigate to your MyFaves submenu, and then use Edit > Paste to stock your new menu.

Save your changes. Now, you'll have a MyFaves menu wherever you've placed it.

To put this new menu in your top panel, right click on
your top panel, and -- Add Application to Panel.

Then, navigate through the menu system that will pop up, and keep moving until you find your MyFaves menu. Move your mouse into that menu, and select Add This Menu.

You should have your specialized menu in your top panel now.

Many times there is more than one way to get what you want. Here is an alternate procedure that I used. It puts one folder on your desktop that can be added to a panel.

Right click on the desktop and choose Add New > Folder. Name it MyFaves or whatever your choice may be and open the folder.

Go into the KDE menu and navigate to the program you want. Drag the icon from the KDE menu to the new folder (It's easier if the open folder is 'under' the KDE menu when you do it.) You will get a drop menu asking if you want to Move Here or Link Here - choose Link. You will now have a link to that program in your folder. Repeat the procedure for every program you want.

Close the folder, then left-click and drag it to your panel. You will have an icon of a folder (which you can change if you want) and when you click on the folder, you will get a drop-down list of the links in it, from which you can open your program. If you find another program later, all you have to do is open the desktop folder and add it there.

Have fun!
Do you use the Internet to do your banking? Do you go on sites that need a password? How safe are you on the Net? These were some of the questions I asked myself. To come up with answers I turned to some technology resources. It might surprise you what I found.

To set a good password is a bit of a hit and miss proposition for most people. Some use birthdates, others their pet's name or spouse's name. Unfortunately, these are not strong passwords in this day of Internet use.

Also, re-using identities on the net, as well as the passwords themselves, puts you at a lot of risk.

"Re-using these identifiers puts people at serious risk of falling victim to identity theft," said the ITU (International Telecommunications Union) report. It called on regulators and businesses to find better ways for people to identify themselves to web sites.

Web sites, in their bid to identify users and track them are causing a proliferation of identities and passwords. "This may cause security breaches, and leave them vulnerable to the machinations of identity thieves (who are) ever increasing in number and inventiveness," said the report.

Hackers today will often use a dictionary style attack. This means they can very quickly use all of the words in the dictionary as well as common celebrity or sports names.

For example, many people still use what they think is a
smart technique of switching out some characters for numbers; for example, changing an A into a 4. That's a very commonly known technique and does not work anymore.

People who steal passwords for illegal use only have to go to social networking sites to get access to your passwords. It is reported that people give too much information out on these sites, like age, favorite film stars, favorite pet, and it does not take long for some of these experts to soon have an idea what password you are probably using.

A lot of people online use only one password to make things easier to remember, but, this in itself is dangerous. Ideally you should have a password for each site that needs one and change it frequently. This means that you could have twenty or so passwords to remember. As they should be in upper and lower case letters as well as numbers, this is going to mean having someplace safe to store them.

There are many choices available, but a new online service from Box Knox is available and offers encrypted storage at no cost, while protecting anonymity. Personally, I prefer to keep my data on my own hard drive so I use a program like mypasswordsafe from the repository. It encrypts the passwords and has password protection. You can even generate new passwords and user names for each site. I find this quite satisfactory for my needs. I change all passwords once a month as well. Even then, complicated passwords, securely stored, do not mean you are safe.

"You can go and use Internet search tools like Google and you'll find lots of free tools that allow you to listen in to someone else's PC." said one security specialist, "Especially if you are an MS Windows user."

Some of the banks in the UK are testing a new system. An alternative being considered by HSBC and the Alliance and Leicester banks in the UK would have
users run an application on their mobile phones to generate a second pass code.

The ever-changing second password may be the thing of the future. It may be the only way to keep users’ secrets secret in the long run.

Let us hope that the day comes when we won’t have to worry any more about these issues; until that day comes, be safe on the Internet and keep your private life ... private.
Free as in Free Beer

For the newcomer to the world of free/libre and open source software the term "free as in free beer" may seem a bit confusing at first. This is an attempt at a clear explanation. I've provided links within the article and at its conclusion for further reading on this subject.

Free Beer

Who but a friend gives you a beer? The guy at the pub expects payment. The guy at the store expects payment. The breweries and micro-breweries expect payment. Each of them has made a financial investment in order to bring you the beer, so expecting a return on the investment is their right. We can't expect them to go broke to supply us with beer, can we?

But a lack of monetary cost is not what is meant by the free in the phrase "free beer." This word has the meaning of freedom and liberty. It is the openness of open source. At http://www.freebeer.org/blog/ you'll find links to the recipes for free beer, the labels for it and other helpful items and information. You may also purchase free beer. How can it be offered for sale and be free? The answer is simple.

You have the liberty — read freedom — to copy and use the recipe and share it with others. The label graphics are supplied, also, so you may label your bottles of beer. You are free to use and share these things. Thus, you are at liberty to make and share this beer. These quotes from the above site, "FREE BEER is a beer which is free in the sense of freedom, not in the sense of free beer" and "The recipe and brand of their beer is published under a Creative Commons License, which
means anyone can use the recipe for pleasure or profit. The only catch: If you make money selling their unique beer, you have to give them credit and publish any changes you make to the recipe under a similar license." This offers an explanation of what 'free beer' is, if you understand the difference between lack of cost and freedom.

How does this relate to software?

Gnu.org offers this explanation of free software (http://www.gnu.org/philosophy/free-sw.html) -

1. The freedom to run the program, for any purpose (freedom 0).
2. The freedom to study how the program works and adapt it to your needs (freedom 1). Access to the source code is a precondition for this.
3. The freedom to redistribute copies, so you can help your neighbor (freedom 2).
4. The freedom to improve the program and release your improvements to the public so that the whole community benefits (freedom 3). Access to the source code is a precondition for this.

"A program is free software if users have all of these freedoms. Thus, you should be free to redistribute copies, either with or without modifications, either gratis or charging a fee for distribution, to anyone anywhere. Being free to do these things means (among other things) that you do not have to ask or pay for permission."

"When talking about free software, it is best to avoid using terms like 'give away' or 'for free' because those terms imply that the issue is about price, not freedom."

The concept here is simple — you are at liberty to use or improve F/LOSS programs or not, at your own choosing. You are free, as in 'free speech' to make your own choices. The software may be gratis, i.e. without monetary cost, or there may be a fee charged for it. The
free part of F/LOSS is then not about the monetary costs, but about your liberty.

Conclusion

When you see, or hear the statement "Free as in free beer" applied to software, it should be considered a statement about your right to choose. You are at liberty, i.e. free to choose, to use, distribute or change the software, so long as you share that liberty with everyone. No one may be denied this liberty. If anyone is denied, the freedom is lost.

Enjoy your freedom and remember to share it.
Freedom/liberty is one of those things that increases when given away.

"There's no such thing as free lunch." - Robert A. Heinlein, quoted from The Moon is a Harsh Mistress

Nothing is without cost. What about gratis, you ask? Yes, even gratis has a cost. The developer who created the software that you receive without monetary cost has paid for the hardware that the software was developed on, used his/her valuable time in that development and provided a website from which the software and source code may be downloaded. Every piece of software ever written has been paid for by someone. Every download site has been paid for by someone. It is for help in the defraying of these costs that there are donation links on websites where software and operating systems are made available gratis.

Links for further reading:

http://en.wikipedia.org/wiki/Free_as_in_beer
http://www.gnu.org/
http://www.fsf.org/
http://en.wikipedia.org/wiki/Free_software
What NOT To Do When Bored of Testing 2007

Yes, testing 2007 is boring, tediously, horribly boring. The darn thing just works. And where's the thrill there? So you're bored, and you notice something. A key on your laptop isn't quite right. Maybe it's sticking, maybe it's got a bit of pizza crust lodged under it - at any rate, for whatever reason, whether it be a genuine mechanical failure, or possibly some micro-stroke, or other cerebral vascular trauma, you decide to take apart your laptop keyboard. I can give you a bit of advice. Don't. Just don't. I'm not talking the polite Nancy Reagan "Just say no" don't. I mean, for the love of all you hold dear, for the sake of your sanity, for those who love and need you - DON'T!

Perhaps you feel the malfunctioning key is needed. I assure you, it's not. You can type perfectly intelligible sentences without the use of most of your keys. Hones. Alternately, you can just use the trick of changing keyboard layouts. Type your document, then go into your system configuration and switch the keyboard layout to Dvorak (which you should be using anyway) and fill in the missing letters.

Even better. Lock your laptop in the attic, and move away. Just sell the house. Ever see 'Poltergeist'? Trust me, once your laptop keyboard malfunctions, you're better off just walking away. Only evil can come of sticking around and messing with forces that are darker and more powerful than you can imagine. Let the next owners of your house unlock that fateful door one day. It's their problem.
"But", you say, "I used to take apart my old IBM Model M keyboard all the time, stick the bits in the dishwasher, and be back and running in thirty minutes!" Well, all I can say to that is...you poor deluded fool. First of all, the IBM Model M keyboard (possibly the finest keyboard ever conceived on this, or any other world) was a military grade, field serviceable piece of cold war digital combat equipment. It was designed to be field-stripped in the dark by Pentagon typists after a nuclear holocaust and built to outlast God while serving as a combination fallout shelter and self defense weapon.

Your laptop keyboard on the other hand, was conceived and executed by a tribe of mutant dwarfs, somewhere in the foothills of the Taiwanese Alps to do exactly two things - take up less than one-inch of vertical space and weigh approximately three grams. To do that requires not engineering, but voodoo. I'm talking serious mojo here, and when the mojo breaks, you're just better off not messing with it.

But I see that, like Captain Ahab, you are intent on your doomed pursuit. Very well. You will need a few things. You will need a thin-walled plastic container, a slender implement, such as your average Swiss army knife, some epoxy, and alcohol. The alcohol is not for the keyboard, it's for you. I suggest Jack Daniels, but some have reported satisfactory results with gin or rum.

You will also need some knowledge. Search the web for "replace laptop keys", and read carefully. Some sites will helpfully explain that you should pry gently on the right side of the key, unless you have a left-side-prying keyboard. Right. Others purport to show pictures of the disassembly, taken with scanning electron microscopes. Keep in mind that on the web, I have also seen pictures of Jimmy Hoffa flying a UFO into the World Trade Center. These photos are fakes, done in Photoshop (I mean the keyboard photos - the Hoffa photos are real). And there is no such thing as a "right-prying" or "left-prying" keyboard. This is just a cruel prank.
First, you will need to take the thin-walled plastic container and cut a few circles out of it. Mix up your epoxy, and use it to attach the plastic circles over every possible inlet or outlet in your bathroom, which is where we'll be working. Or, to be more precise, we'll be working in the bathtub. When those tiny plastic pieces start flying around, you'll be glad you listened. (Note: you don't have to epoxy your toilet - just wrap it in two or three layers of duct tape) While you're waiting for the epoxy to harden, pour yourself a shot of the alcohol mentioned above. You'll be glad you did.

Now that the epoxy has hardened, move your project into the tub, close the shower curtain and begin prying on the keys in question with your prying implement, mentioned above. Where you pry doesn't much matter; as I mentioned above, the notion of "left-prying", or "right-prying" keyboards is just foolishness. You will hear a slight click, as you apply pressure. You will next hear a naughty word or two as plastic pieces pop loose and fly all over the tub. The websites show the keycap neatly coming loose, leaving an ingenious little x-frame that supports the keycap and gives it its "action". These websites, as I explained earlier, are lies. Actually the whole darn thing flies apart in four different directions.

Step out of the bathroom (did I mention you should be doing this without clothing, by the way? When those little pieces jump off your keyboard, they can be lodged in any piece of clothing, where you will not find them, and they will not dislodge until you are someplace where they can fall and never be found. So just work in the nude. It's a bathtub, OK? You've done this before) and pour yourself another drink.

Take a deep breath, march back into the bathroom and examine things. The first thing you will notice, in the vacant space left by the keycap, is enough hair to let a Tibetan yak join the Men's Hair Club. This is normal. I've seen a lot of keyboards and they all have it. I'm sure the manufacturers put it there for a reason, so it's best to just leave it be.
The next thing you will notice, if it's an "x-frame"-type keyboard, is that that among the pieces that popped loose, there are two tiny ladder-like parts and one flat piece. You will notice that each of these pieces looks as if it might be capable of being rotated in either the X or the Y dimension and still fit together. Some of you binary math types have already figured that means there are sixty-three possible wrong ways, and one right way to reassemble things. I love you binary math types. However, you are wrong. Actually, there are sixty-four possible wrong ways, and no right way. So there.

What you need is an intact example. So go ahead and try prying a few more keycaps off. Heck, maybe one of them will pop off neatly, leaving a perfectly-assembled x-frame for you to use as a reference. Right. When you get tired of this exercise, your next best bet is to maybe get a good X-ray of your keyboard. This is easier than you think. Dress as Osama bin Laden, and try to board an aircraft at your local airport with no boarding pass. After the security folks quit chuckling, they'll be glad to give you a copy of the x-rays. And, after you get back home, and have another drink or two, the body-cavity search won't seem nearly as bad.

But you will discover a problem. No matter how hard you squint at the x-rays, it's just impossible to make out the structure of the plastic key bits against the much stronger shadows made by all the metal bits in your laptop. Which is why radiologists get paid what they do. So it's back to square one. Have another drink, shed your Osama costume and head back to the bathroom. Try prying off the least used keys, as they may be less likely to fly into bits. I suggest the F11 key. It's only known purpose is to separate the F10 key from the F12 key. In all the history of computing, nobody has ever pressed this key, and in fact, on many keyboards, it's not even wired in.

When (if) you successfully get a key off that leaves the little x-frame intact, study it carefully. You will notice that there are remarkably few details that give a clue to the
correct orientation of the pieces. In fact, there are no such details - but if you get it wrong, it won’t work. So start trying to stick your pieces together. You may have to drag the bottle of alcohol into the bathroom with you, just to keep your hands steady as you work with the tiny plastic parts that are trying their best to fly apart. Keep trying. Remember, there's only a finite number of ways these pieces can go together.

Persistence may pay off. Or it may not. When after a few days, your friends or relatives have convinced the police to break down your door, and they find you, nude, lying in your bathtub, with duct-tape and epoxy over all the fixtures, bottles of Jack Daniels lying around as you drool over a pile of plastic pieces, you'll get the help you need. I promise. And by the time you get out of the institution, laptops will be smart enough that you can talk to them without ever touching a keyboard.
I have been playing around with networking, on and off, for maybe the past six months or more. I have installed all sorts of networking packages and succeeded in getting my small home network working OK using a couple of different methods. No Win boxes here!

Having decided that all this network stuff was complete overkill for my needs, sharing only specified files with other PCs on the LAN, I have decided to install the very minimum network packages when I get the final PCLOS 2007 release. So I am preparing to share files without the network set up, for the most part, which I never fully understood anyway. Too many seemingly 'same' settings are in different places. OK, I know it is simple, but obviously not simple enough for me.

There would also be the odd occasion that I would wish to share some documents with a friend in a remote location, maybe even share some photographs or videos. The documents were never a problem, as I could send them by email; videos are of course a different matter. They are too big for some ISPs to let through. I needed a method to share these with my friend also.

I believe, I have found the ideal solution for me; I stress 'for me.' I believe this will work for me for several reasons:

I am behind a Router/Firewall
I only need it intermittently
It is a small home set up, presently three PCs, maximum of probably eight.
The most important reason, it is SIMPLE!
On one machine, I have my music stored on a separate partition. This is the PC that I use to play the music I want; it has the best audio output of the lot. On all the machines, I've set up a directory on the Desktop, called Shared, into which I put what I wish to share. In this way I determine what is shared without having to worry about using locations into which I might inadvertently place a file that should not be shared. I set up shares on each PC for all the 'Shared' directories and also the Music partition.

To set up the shares I used the Public File Server applet of KDE, (right click on Kicker and Add Applet), on all machines and set up one share - the shared folder. On the music machine, I set up a second share for that partition — right click on the tray icon and select Add Server. Each machine's Shared folder can be seen on all the others simply by entering the IP address of the machine, followed by the port number on which the share is available - something like http://192.168.3.121:8006 - into the web browser. The contents of the Shared directory are displayed. If Zeroconf is running, then the IP address can be dispensed with and the broadcast name of the machine used in its place. This is useful where the IP address may change due to DHCP being used. So if I have named a computer "Bunny", I would put into the browser something like this - http://bunny:8006 - and have the contents of the Shared directory on "Bunny" displayed in my browser.

OK, I reckon I am sorted for home use. The users need know nothing about networks, NetBIOS names, or anything concerned with networking. They have no permanent shares set up. All they need to know is that anything in the "Shared" folder on their Desktop is shared with everybody else, and to access the Shared folder on the other machines they just type in the machine name and port number into their browser. These users are trusted, but they can
regard everything else as private (if not ultra secure). In any case, the machines being all in the one house makes them physically available if anyone here wishes to break into them. Access to the shared folder set up on Port 8003 on the PC named Pentium_D looks like this:

To share the odd file with my remote friend we set up Hamachi (from the PCLOS repository) on our two computers; set up a virtual LAN, and then a Shared folder, using the KPF applet, on our PCs, that we could each access. Now he has access to the files I wish to share with him and I have access to files he wishes to share with me. All that was required was to set up a separate share directory and port number to do this. It is a matter of a few clicks of the mouse to set one up and a couple of clicks stops it. I can monitor what is being accessed and by whom in each shared folder.

**Negatives:** All shared files on the local LAN are visible to everybody on the LAN. They would be visible to the WAN except for the Router/Firewall. Also, the speed of Data transfer appears to be limited to 5Mb per second.

It is possible, if I left my local share active, that my remote friend could access it if he guessed the port number being used, but I wouldn’t be sharing anything with him unless I trusted him.

There is no built-in security using the Applet so I am dependent on the firewall in the router for security. I might get around to enabling the software firewalls on each computer to pass through requests on the specific ports. This would give more security but involve a bit more work, which I am anxious to avoid.
So that's the story. It is by no means ideal, but I think it will serve my needs and be sufficiently secure.

Konqueror Plays Music

If I access a folder on the music share containing MP3 files and click on a file, then I get a pop up offering to d/load it or launch Amarok (default?) to play it. If instead, I put the location AND the file name into the Konqueror location bar, then Konqueror will show me the controls of a player and by clicking on the Play button the file will be played in Konqueror.

Stream Music over Your LAN

For anyone who wishes to stream their music from their store location for all PCs on the LAN to listen to, it can be done with Kaffeine - FILE-NETWORK Broadcasting - Send Broadcast Stream, and pick a port number. All PCs on the network can then listen to what is being played by using Kaffeine - File Network Broadcasting - Receive Broadcast Stream.

Kaffeine will also stream other types of media of course. You could play a video on the store machine, setting Kaffeine to broadcast it, and watch it on any PC on your LAN. Cool!
What is Root?

CogDis: Here are a couple of excerpts from a previous discussion on the forum:

One of the things I have found in helping new Linux users understand the Linux way of doing things is that the concept of "root" can be a bit perplexing because of the inconsistent way it is used in the Linux lexicon. In much the same way a new computer user might confuse the concept of gigabytes of RAM with gigabytes of hard disk space, so too can newer Linux users be confused with the various connotations of root. I hope this may shed some light for someone.

1. First of all there is "/" (pronounced root), the top most level of the root file system (as in root directory or folder). I find it ironic that "/" is used to describe the topmost level of the Linux file system when most of us probably would intuit just the opposite ... but I digress. You might think of "/" as the container for the entire root file system.

2. The root file system. Often represented as "/" but really encompassing all of the files and folders that make up the Linux operating system.

3. The root partition. The physical partition or drive that the root file system lives on. Also frequently referred to as "/".

4. /root. This is not the root partition or root file system, but the home folder of the root user.

5. root. Most frequently used to denote the user "root". Or more specifically, the name of the login account of
the the administrative user that has full file system
access privileges. Also known as superuser.

6. As root, gain root, root access, etc. That is, perform
some action with the administrative privileges of the root
user.

You see, "root" has various connotations dependent
upon the context in which it is used. It is no wonder that
it is hard for many of us to grasp at first.

We won't even get into root-window, rootkit, get rooted,
root portal, chroot and many other similarly phrased
terms. Yikes!

M wananchi: It seems odd, that the root partition
(hda1, hdb1, etc.) is stuck in the midst of the file system
under /mnt, because then where do all the folders and
everything above root reside?

...everything above root? root is like G O D in your
system, there is no "above root", everything is and must
be under HIM. The whole universe is under "/". The
universe is the "/", going above this is like going over the
boundary of the universe, or cruising past the speed of
light! What are you going to see? It just doesn't make
sense.

HE has his own chilling place at '/root', where he puts
his personal stuff and where his desktop is. It's locked
because he is just personal.

You live in HIS universe and you have your own place to
grow up in called "home directory", you live in
'/home/you'.

He occasionally allows an extension to his universe
from others, i.e. USB devices, hard drives, CD-ROMS,
floppy drives, under '/mnt', but this isn't a requirement,
HE just likes them there since HE can remember where
they are all the time.
HE occasionally allows HIS children to fiddle around in places they shouldn't be by giving them temporary access to HIS powers by requiring them to provide a root access password.

HE is a very forgetful GOD so he keeps most of his physical assets in '/dev', a folder where ironically His universe is attached. (/dev/hdx).

He keeps most of his likes and dislikes about how HE runs his universe in '/etc'. He provided a nice place where his children and anyone who cares to know may find out what he is up to in '/proc'. Want to know what he is smoking? Well, hang around there, and if you pray hard enough, you might find out.

What of the lost+found place? Well, He generally puts things there that He doesn't know/remember where they are supposed to be. It's locked because you aren't supposed to "see" his mistakes.

Exwintech: In some locations, where the English spoken is not of the exceptionally well-mannered American type, the Linux Name of the Ultimate Administrator (other than Tex or Linus, natch) is a reference to the 'human procreative act' - I hope that's a sufficiently polite way to put it. It is most awkward to have to attempt to explain to those of the female gender, in these Regions of non-American (Australian) English, that they must 'su to root', to do 'Admin Tasks', as they think of it in Other Systems.

The term 'su' can sound the same when spoken, as the diminutive form of the name 'Susan', as in 'Sue'. So when used in the context meaning 'Change to Admin Mode', the connotations can be misleading, especially to ladies not at all familiar with Linux, who assume 'root' to mean something with which a plant gains nutrients from the soil, or the above slang or dialectic reference.

Perhaps some of the Forum Members from non-English-speaking regions could tell us what 'Linux Admin Mode'
is in other languages, and at least those who prefer to — when speaking to those, of course, not only ladies, as yet unfamiliar with Linux, could choose and use another word for it. A hem.

Ahh, well, off now, to find my tongue-from-cheek remover.

**Merlin Whitewolf:** Just one question for now - What arcane artifacts of electronic power does 'He' put in 
"/var"?

**Algernon:** Let's call it "runtime information" ... the stuff that gets dynamically generated when applications run.

There are however exceptions, since a lot of very different things go in '/var'.

Examples: '/var/log' is the repository of all logs (mostly generated by services or the kernel itself); '/var/run' is where daemons put runtime info such as their PID so other programs may detect their existence; '/var/spool' stores the job queue for all daemons which need one (cron, at, cups, mail...); '/var/lock' contains the lock files used to detect whether another process - or another instance of the same process - are using a non-shareable resource; '/var/cache' provides a good place to cache stuff for programs that need it (apt/synaptic, samba,...).

Other directories, like '/var/ftp' or '/var/www' can be used (though not necessarily) as homeland for very specific servers, such as FTP servers or Apache servers. In the latter case, the directory '/srv/www' is as far as I know frequently used to store websites. And then there are even more things in '/var'.

You see, it's hard to give a general definition.

**Abmman:** Well, root does not have any ambiguous meaning in Danish, but if you abbreviate Linux Admin Mode to LAM, it means either lame (in all senses of the
word) or lamb. Much more funny is MUG (Microsoft User Group), which in Danish means "mold".

**Davecs:** In English, MUG, as well as a large square cup, also means Face (mug-shot, ugly mug, etc) or Victim of a Scam or Robbery. (He is the mug. He was mugged). It is also general slang for fool.

**Exwintech:** Root isn't the Ultimate Power in Linux, if the said Linux is running KDE. Root can be overridden at will/random - by Konqueror... Well documented by me in the Sandbox.

**Vampirefo:** The ultimate power is the person sitting in the chair typing. We control the PC not root. Root, plainly and simply, is the administrator.
Bringing Linux to the Kids

I was inspired recently. I read about Nicholas Negroponte’s “One Laptop Per Child” (OLPC) project, and suddenly, I caught a glimpse of his vision. Imagine millions, no, tens of millions of little kids all over the planet using open source software. All those children introduced to computers, to open software, to the ideals of shared information, instead of the shackles of enforced intellectual property licensing. I saw a dark globe, spinning in the vast blackness of space, shadowed, until a spark appeared—a pinpoint of light in the darkness, then another, then dozens, then thousands, until the whole planet was blazing with the light of young minds connecting, learning, sharing. I got a bit breathless. Without warning, I became a disciple— I had a mission.

The next time the grandkids were over, I remembered my mission. But Lil’ Mike is, well, too little. At one, he’s just made the fascinating discovery that his nostrils and his fingers fit together rather neatly. So I turned to big sister, Aniah. Don’t ask me to explain the name. Aniah’s mom, “Mom” says it seemed like a neat name at the time. I say we never saw some of these odd names until we got reeeeally good labor and delivery drugs. But Aniah was perfect for my mission. Going on three, she’s a speaking, reasoning little human. What better time to start introducing computers?

Mom doesn’t think Aniah’s going to be “into” computers. Mom thinks Aniah is going to be a dancer. Of course, Mom also thinks that “Reality TV” is, well, real. Now, I will admit, Aniah can dance. She can do a startling Paula Abdul when ‘Straight Up’ comes on the TV. When she was around two, we went to the beach, and had
dinner at a restaurant on the pier. There were a couple of musicians about my vintage on a little platform stage, covering the 70's and 80's hits. Aniah went right up to the stage and started dancing. She had a different dance for every style of music, and the musicians were having fun trying her with different songs. The customers were having fun, too, and started filling the tip jar. That doesn't mean she's going to be a dancer, it just means she can dance. She can learn to use a computer, too. Right?

So I fired up KWrite, set the font to a nice green color, and a huge size. I got another chair, and invited Aniah to the computer. Our dog, "Dawg" followed, and sat beside us, watching intently. Dawg is usually not much interested in open source, or computers in general. Dawg has simply figured out that toddlers in the house mean plenty of spilled food. (Dawg is pretty sharp, in his own way.) So I typed Aniah's name, slowly hitting each key and saying each letter as I pointed to the screen - A...N...I...A...H - Aniah! She thought that was great, and intently watched everything I did through the whole process.

I slid the keyboard over to her and said, "You do it." Aniah pushed it right back and said, "No! You do!" So I did. A...N...I...A...H - Aniah! We repeated this exercise a few times, until Dawg got bored and laid down. I finally took Aniah's hand, and pushed her finger on the "A" key, and said "A". She started to get it. I pointed at the "N" - she pressed "Q". Okay, I'll follow her lead, so I said "Q". She pushed a few more keys at random, with me saying the letter and pointing to the screen each time. Mom brought us a plate of crackers and peanut butter, and Dawg sat up, suddenly interested in the lesson again.

Aniah decided to pick up the pace a little, and started clicking keys faster and faster, as I tried to keep up, saying the letters and pointing. She escalated to mashing multiple keys, and in about 3.5 seconds managed to hit Ctrl-Alt-Backspace, which shut down the session. I slid the keyboard back, and started logging back in. I glanced over at Aniah, and she was happily
eating a peanut butter cracker with one hand while trying to remove one of Dawg's ears with the other. Dawg had a pained expression on his face, but he'll put up with a lot if there's food involved. Dogs are a bit like husbands that way.

Clearly, it was time for a break. I sent Aniah off to watch TV with Mom, Dawg following the cracker crumb trail, while I rethought my strategy. Maybe the keyboard wasn't the right interface. Possibly the mouse would be better. Something graphical. I browsed through the PC LinuxOS software repository looking for the right application. Then I had it, TuxPaint. Just the thing. I use it all the time for web site design. Some folks rave about the GIMP, but I find that all those bells and whistles just get in the way of the creative process. Give me TuxPaint every time. If a customer needs a rainbow-striped snake, or lots of stamped flowers on their page, it is the ideal tool, and one of the trade secrets that a lot of web designers will deny to their last breath.

So I fired up TuxPaint in full-screen, and went looking for Aniah. Mom was in the den, watching a music video channel that was playing oldies. 'U Can't Touch This' was on, and Aniah was in front of the TV, one pair of baggy pants shy of being one of MC's backup dancers, doing a pretty fair Hammer Dance. After the video, we went back to the computer, and I started showing her TuxPaint, clicking on the tools and drawing on the screen. Aniah liked it, and even Dawg seemed interested, although I did still have those peanut butter crackers sitting on the monitor. Aniah took the mouse and started scooting it all over the desk. I spent about twenty minutes trying to teach her to click and slide, but we just weren't getting there. So I thought we'd try the keyboard thing again. I clicked on the text tool and typed a couple of letters.

Aniah got the idea immediately this time. She picked up the mouse and started banging on the keyboard with it, popping half a dozen keycaps loose. Dawg was sniffing hopefully at the keycaps that had hit the floor, and I
thought it might be time for another little break. Aniah grabbed another peanut butter cracker and went bouncing off to the den, Dawg trailing faithfully in her wake, while I took a deep breath and began putting the keyboard back together.

I gathered my thoughts, and decided that the problem was the mouse — moving it and clicking it at the same time was too much. What I needed was an interface Aniah was already familiar with. I knew she could handle a crayon, and a graphics tablet works pretty much the same way. So I unplugged the tablet from my PC, and moved it to the family machine. A few minutes to get X-Windows set up for the tablet, and we were ready to go.

That was the magic. Sort of. Since the pen combines clicking as you move it on the tablet, Aniah did a little better. But she also managed to shut down TuxPaint twice, losing forever a couple of masterpieces worthy of Jackson Pollock. While I was digging around in the documentation, trying to find a "nosutdown" option for TuxPaint, I noticed that Aniah had finished her cracker, and was busy trying to put the tablet pen up one of Dawg's nostrils. Dawg's eyes were watering a little, but he was still game. I extracted the pen, gave Dawg the last of the crackers and decided to call it a day.

Later, after I'd had time to crack open a cold brew, I sat on the porch for a while and reflected on the day. I got up and wandered into the den. The music channel was still on the TV, and Aniah was bouncing and twisting. And I had a few revelations.

My first was that we don't pay Dawg nearly enough.

My second was that Aniah's going to be a dancer. Probably. Hopefully, it will involve something a bit more lofty than performing with a couple of beach musicians and a tip jar, but as long as she's happy...

My final revelation? Nick Negroponte has his work cut out for him.
Vista Sucks Big Time

by R. Adkins

Vista, the much hyped up, latest, Bill Gates offering to the world, sucks big time in my opinion.

My daughter bought a new laptop last week. Once she got it home, she could not wait to show me this laptop with a gig of ram, 85 gig hard drive, and Vista Home Premium as the operating system. She was kind enough to let me take a look at the new laptop and Vista.

When I booted the laptop, I sat watching the screen. It had some great graphics on the boot up screen, but it became quite apparent that this operating system took a lot more time, than Windows XP, to boot. I sat waiting; to me it seemed a long time, but it finally booted and the laptop was up and running.

Personally, I run some pretty old computers in my house; a P2 450 with 128 megs of RAM and a P3 800 with 384 megs of RAM, so I was expecting great things when this laptop had a gig installed. To tell the truth, I was disappointed in the speed of the machine, but then I realized this thing uses half the RAM just to run the operating system. To me, that seemed to be an incredible amount of ram needed. It made me wonder what it will use when it has been installed for six months and the registry gets bloated.

One of the things that annoyed me right away were the pop-ups that ask if you want to do this or that. The permission thing drove me nuts after a few minutes, and if I owned the computer, it would be the first thing that I would turn off.

Vista’s eye candy looks great; the start menu is close
enough to XP's that I don't think it would confuse many Windows XP users, but the way the system does things has changed. As my daughter did not have too much installed on the machine, there was not much I could do with it. I checked out the Office program but it is more than I would ever need.

In the stores today, curious to see the price, I walked over to the software department. Having seen the prices on the different Vista boxes, I would not consider buying it. Here again is where Vista sucks. It will suck the money right out of your wallet!

If you are running XP, I personally cannot see anything on Home Premium that would warrant an upgrade. My advice is stick with XP until you really do need a new computer. Apparently I am not alone in my thinking as today's reports say that retailers have sold only half the amount of shrink-wrapped Vistas to date as they did when Windows XP was launched. Also, Microsoft has dialed back expectations on profits because of the lack of sales. Vista sucked the share price down as well.

Will I upgrade to Vista? Nope, I will upgrade to PCLinuxOS 2007 being released around the end of this month. It is coming with 3D (yes, I know Vista has that), it has translucency (yes, Vista has that), it has beautiful eye candy (yes, Vista) and it also comes with a complete Graphical User Interface (GUI). In other words, you don't need to use a command line tool, (yes, I know, Vista does that as well) and it is FREE (I know, Vista does not do that)!

Definition of free? Free to download, free to share, free to modify, free to install on as many computers as you need it to be installed on, free to give to your friends and family! Yes, I know Vista does not do THAT! I always did say PCLinuxOS was better than Windows - it does more than Vista!
DISCLAIMER

1. All the contents of PCLinuxOS Magazine (http://mag.MyPCLinuxOS.com), are intended for general information and/or use only. Such contents do not constitute advice and should not be relied upon in making (or refraining from making) any decision. Any specific advice or replies to queries in any part of the magazine is/are the personal opinion(s) of such experts/consultants/persons and are not subscribed to by PCLinuxOS Magazine.

2. The information in PCLinuxOS Magazine (http://mag.MyPCLinuxOS.com), is provided on an "AS IS" basis, and all warranties expressed or implied, of any kind, regarding any matter pertaining to any information, advice or replies, are disclaimed and excluded.

3. PCLinuxOS Magazine (http://mag.MyPCLinuxOS.com), and its associates shall not be liable, at any time for damages (including, without limitation, damages for loss of any kind) arising in contract, tort, or otherwise from the use of, or inability to use, the magazine or any of its contents, or from any action taken (or refrained from being taken) as a result of using the magazine or any such contents or for failure of performance, error, omission, interruption, deletion, defect, delay in operation or transmission, computer virus, communications line failure, theft or destruction or unauthorized access to, alteration of, or use of, information contained in the magazine.

4. No representation, warranties, or guarantees whatsoever are made as to the accuracy, adequacy, reliability, completeness, suitability, or applicability of the information to a particular situation.

5. Certain links on the magazine lead to resources located on other servers maintained by third parties over whom PCLinuxOS Magazine (http://mag.MyPCLinuxOS.com) has no control or connection, business or otherwise. These sites are external to PCLinuxOS Magazine (http://mag.MyPCLinuxOS.com) and by visiting these, you are doing so of your own accord and assume all responsibility for such action.

Material Submitted by Users

A majority of sections in the magazine contain materials submitted by users. PCLinuxOS Magazine (http://mag.MyPCLinuxOS.com) accepts no responsibility for the content, accuracy, and conformity to applicable laws of such material.

Entire Agreement

These items constitute the entire agreement between the parties with respect to the subject matter hereof, and supersedes and replaces all prior or contemporaneous understandings or agreements, written or oral, regarding such subject matter.